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TOPIC -----------------------------------------------------------

This article contains the Read Me file for the Macintosh LC 630 DOS Compatible.
This version of the Read Me file was included with the PC Setup 1.0.7 update
software package.

DISCUSSION ------------------------------------------------------

Addendum to the Macintosh User's Guide
for the Macintosh LC 630 DOS Compatible

This document contains important information about using your Macintosh LC 630
DOS Compatible that is not included in your user's guide.
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Using the Floppy Drive

Both PC and Macintosh floppy disks are automatically mounted when inserted into
the floppy drive, in either operating environment.  This mounting process takes
a few seconds.  Macintosh users are familiar with this process; PC users will
find that they should wait a few seconds before accessing the data on the floppy
disk.

Certain DOS or Windows floppy disk utilities will not work with the DOS
Compatibility Card.  These utilities attempt to exercise direct control over the
floppy drive, which they cannot do, since it is a Macintosh-controlled floppy
drive.  Instead, Macintosh disk utility applications should be used.

Use of Floppy Disks as Drive Containers

The LC630 DOS Compatible computer does not support the use of 3.5" floppy disks
as drive containers.  Floppy disks are intended for data use only.

Startup Folder/Auto-start PC Conflict

When two or more Macintosh applications are included in the Startup folder, be
sure that the "Auto-start PC" is not selected in the PC Setup control panel.
Under this circumstance you must switch to the PC mode manually and you must
switch only after all Macintosh startup applications have finished launching.

MIDI Transfers Supported on Macintosh Only

The LC 630 DOS Compatible does not have the capability of sending and receiving
MIDI data through the serial port for DOS and Windows.  MIDI data does travel
internally on the PC side, but when connected direct for use with a MIDI
instrument, no data will transfer.  MIDI transfers are fully supported on the
Macintosh side.

Using the Two-Button Mouse

The standard Apple mouse has no right button and users must press the "extended
=" key whenever they intend to use right button functions in one of their PC
applications.  However, users of a third party programmable mouse or trackball,
such as Kensington Turbo Mouse 4.0 or Logitech MouseMan ADB, can use the
utilities included with their mouse to map the "extended =" key to the right
hand button.

The Kensington Turbo Mouse 4.0 includes two utilities to configure its buttons.
They are: "Turbo Mouse Control 4.0.2" and "Turbo Mouse Basics 4.0.2".  "Turbo
Mouse Control 4.0.2", an application that requires an extension, does not
effectively map the "extended =" key to the right button and should not be used.
 "Turbo Mouse Basics 4.0.2", a control panel, correctly maps the "extended ="
key to the right button and should be used instead.



Using a Flightstick Pro Joystick

The Flightstick Pro Joystick for the Macintosh triggers the System beep 'Indigo'
when entering the DOS environment.  It also triggers this sound twice upon
bootup.  To correct this, remove the Indigo sound from the System file in the
Macintosh System Folder.

Bypassing the CONFIG.SYS and AUTOEXEC.BAT files

To bypass these DOS startup files during the startup process, press and hold the
F5 key (Command-5 on non-extended keyboards) after the memory testing is
complete.

Installing Corel Draw

If you allow Corel Draw to update the AUTOEXEC.BAT file, the line:
LH C:\Apple\MacShare

is replaced with the line:
C:\DOS\SHARE.EXE /L:500 /F:5100

If the former line is needed, you should edit the AUTOEXEC.BAT file to add it
back.

Using Norton Utilities

If Norton Utilities for the Macintosh v3.0 or v3.1 is being used, the "More
Compatible" option should be chosen:

1. Go into Control Panels and open FileSaver
2. Click More Choices
3. Click Preferences and Update Now
4. Click More Compatible
5. Click Save

Installing Microsoft Office, Word, or Excel

When you install Microsoft Office 4.2c or later, Microsoft Word 6.0c or later,
or Microsoft Excel 5.0c or later, make sure that you use a CD-ROM installation
disc or floppy disks that are non-DMF. (DMF is Distribution Media Format,
Microsoft's recently changed installation disk format. DMF disks store 1.7 MB of
data rather than the 1.44 MB on a single 3.5 inch high-density disk. During
installation with DMF disks, an error will be reported when installing the
second disk, and you won't be able to complete the installation.)

Non-DMF installation disks can be obtained from Microsoft by calling
1-800-426-9400.



Amendments to Appendix E of the Macintosh User's Guide

On page 164 of the Macintosh User's Guide, certain steps may not exactly apply
to more recent versions of the Novell Netware Client disk set.  For steps 4
through 7 of the procedure in the manual, all that matters is that the following
exceptions apply:

The Netware directory is:   C:\NWCLIENT
The LASTDRIVE setting in the CONFIG.SYS file is:   LASTDRIVE=Z
The AUTOEXEC.BAT file contains the line:   CALL C:\NWCLIENT\STARTNET.BAT
And be sure to load the Windows support in the directory where you have loaded
Windows.

In steps 5 and 6, the defaults are already preset; you should not be required to
edit the CONFIG.SYS file to set the LASTDRIVE setting or the AUTOEXEC.BAT file
to add the CALL line.

In steps 8 through 10 of the same procedure: Step 8 should read "To select the
driver for the network board, press return". The disk required in step 9 is the
"DOS Compatibility Installer Disk for PC Environment" disk that came with your
computer. In step 10 select the "Macintosh DOS Compatible Ethernet Adapter" and
press return.

In the section entitled "Conserving Memory", you should not need to edit the
AUTOEXEC.BAT file.  The CALL line should already be included.

Using SAM 4.0

When using SAM 4.0 for the Macintosh with the "Prompt: 'Skip' is the default
button" check box selected in the Floppy Drive preferences, inserting a floppy
while in the PC environment causes the system to hang.  The floppy cannot be
accessed nor can the user switch to the Macintosh environment.  To avoid this,
select the "Always scan" option.

SAM Intercept v4.0.2 Virus Checking

If you have SAM Intercept 4.0.2 running on your LC630 DOS Compatible, and you
attempt to mount a drive container on the desktop, the mouse cursor will
indicate that you have control when, in fact, you do not.  (SAM Intercept is
checking the drive container for viruses but has not displayed the spinning
"beach ball" cursor.)  It takes approximately two minutes to complete the virus
scan, after which the LC630 DOS Compatible will function normally.  Version 4.0
of SAM Intercept does not exhibit this behavior.

To avoid this delay, turn off the autoscan feature as follows:

1.  Launch the SAM Intercept program
2.  Select "Scan" in the "Options" menu
3.  Deselect the"Scan for known viruses" option.



Reinstalling DOS/Windows Software - WB.EXE File

Should it become necessary for you to re-install the DOS/Windows software, you
will also need to install the WB.EXE file for execution when DOS boots.  To
install WB.EXE on the LC630 DOS Compatible follow these steps from the Macintosh
desktop:

1. Select the PCSetup control panel and select "Shut Down PC".
2. Open the PC drive container, located on your internal hard drive, by double
clicking the file "PC Drive File".
3. A hard drive icon labeled "PC BOOTDISK" will appear on the desktop.
Double-click PC BOOTDISK to open the volume.
4. Insert the disk labeled "DOS Compatibility Installer Disk for PC
Environment".  Double-click on the diskette icon to open the main window and
locate the file WB.EXE.
5. Drag it to the folder labeled "Apple".
6. When the Macintosh is finished copying the WB.EXE file, press
command-Return.
7. When DOS has finished booting, type:

EDIT C:AUTOEXEC.BAT

8. Add the following line to the end of the AUTOEXEC.BAT file:

C:\APPLE\WB.EXE

9. Press Option-f to select the file menu.
10. Select the Exit option (using the up-arrow key) and press Return.
11. Press return again to save the AUTOEXEC.BAT file and exit the DOS editor.
12. At the DOS prompt type Command-Return to re-enter the Macintosh desktop.
13. Unmount the PC drive container by dragging the PC BOOTDISK icon to the
Trash.
14. Select "Shut Down PC" in the PCSetup control panel.
15. Start the PC using the PCSetup control panel or by pressing Command-Return.

The WB.EXE program runs and exits when DOS boots. It does not stay resident in
memory.  The WB.EXE program enables the write back mode and prints a string that
reads:

"WB.EXE Enable CPU internal cache to Write-Back.", and exits.

Printing

For DOS or Windows printing on the DOS Compatibility Card, we recommend using
LPT1.DOS or LPT1.  In general you must use printers that are Macintosh
compatible, and use their corresponding printer extension for the Macintosh,
selectable in the Chooser.  However, in a PC Novell Netware environment you can
print to a PC-compatible printer attached to a Novell network (refer to the
Network Installation Guide on how to set up a Novell client).



Printing to a Postscript Printer

If you have a Postscript printer, open the Printers icon in the Windows Control
Panel and select a Postscript driver.  We recommend the Laserwriter IINT driver
or Windows Postscript driver.  In the Macintosh Chooser, select the
corresponding printer extension for your type of printer.

Printing to a QuickDraw Printer

If you have a QuickDraw (non-Postscript, non-PCL printer) such as an Apple's
ImageWriter or StyleWriter, or HP's DeskJet printer:

•  Open the Printers icon in the Windows Control Panel and select the Epson
LQ-2500 driver.
•  In the Macintosh Chooser, select the corresponding printer extension for your
type of printer.
•  In the Macintosh Extension folder, launch the PC Print Spooler by
double-clicking its icon in the Extension folder.
•  From the File menu, select "Preferences".
•  Click on the Epson option for "Interpret non-Postscript As" to enable the
Epson emulator.

The Epson emulator works by first translating the DOS text to a similar
Macintosh font, then interpreting that text into a series of QuickDraw commands.
 Some characters in the original DOS character set may not have exact
translations to a Macintosh font.  The use of a PostScript font is recommended
in these cases, since use of the PostScript standard requires no translation.

The Epson emulator does not support color or grayscale.  When printing from the
PC to a Color or Grayscale printer, make sure to select the Black & White option
from the Print dialog.

Printing to a PCL Printer

When printing to a PCL (Page Control Language) printer, printing is limited to
text-only when printing over an AppleTalk connection.  To set up this
configuration:

•  Open the Printers icon in the Windows Control Panel and select your printer's
driver.
•  In the Macintosh Chooser, select the corresponding printer extension for your
type of printer.
•  In the Macintosh Extension folder, launch the PC Print Spooler by
double-clicking its icon in the Extension folder.
•  From the File menu, select "Preferences".
•  Click on the PCL option for "Interpret non-Postscript As" to enable PCL
printing.

Additionally, PCL printing of text and graphics together is possible when
printing over a Novell network, where a PC print server is connected to the PCL
printer and handles the printing job.  Select your printer's own driver in the



Windows Control Panel.

Sound Control Panel Settings

For sounds generated by the Sound Blaster card and for sounds from the PC, the
Sound Control Panel must be set with the Internal CD playthrough enabled.  The
User's Guide will explain how to make this setting (see pg. 69).  With System
7.1.2, however, the setting is lost after each reboot.  Install the System
Update 3.0 software to correct this problem so that the playthrough setting is
retained after each reboot.

QuickTime also turns off the playthrough option.  This has the effect of cutting
off all PC and Sound Blaster card sounds.  QuickTime v1.6.2 will turn off
playthrough and not restore it, while QuickTime v2.0 will restore playthrough
back to its original state.

Using the Sound Blaster Card

The PC Sound control in the PC Setup control panel does not effect sounds
produced by the Sound Blaster card.  Only PC-generated sounds such as the system
beep are affected by this control. Use the master volume control of the Mixer
Control application from the Audio program group, or turn off the Internal CD
playthrough to turn off both PC and Sound Blaster generated sounds (see pg. 69
of the User's Guide).

The Sound Blaster daughter-card included on your DOS Compatibility Card will
play sounds as expected, but is not able to record them.

The DOS Compatibility Card does not fully support Sound Blaster 8-bit, Sound
Blaster 2.0 or Sound Blaster Pro drivers.  If problems occur, select the Sound
Blaster 16 driver that comes with the DOS Compatibility Card.

Using CD-ROM Drives

Simultaneous use of multiple CD-ROM drives is not supported.

Apple 600i and Apple 600e CD-ROM drives are supported with Apple DOS Compatible
cards when used with Apple CD-ROM extension version 5.0.4. Standard
installations of System Software 7.5.1 or earlier do not include the Apple
CD-ROM 5.0.4 driver. This driver is included with Apple 600e CD-ROM's or can be
obtained from Apple Technical Support.

Audio CDs cannot be controlled from both Windows and the Macintosh environment
at the same time.  One or the other must be used. Photo CD's can not be read on
the PC side of the DOS Compatible.

The PC side sets up a drive letter (E:) for a CD-ROM drive although no drive is
attached.  If no CD-ROM drive is connected to your system, this drive letter can
be freed up (and some memory) by editing these files:



AUTOEXEC.BAT
REM  LH C:\DOS\MSCDEX /D:CDDRVR /L:E

CONFIG.SYS
REM  DEVICE=C:\Apple\CDROM.SYS /D:CDDRVR

Prefacing these commands with "REM" will make DOS ignore them.

Playing an audio CD in Windows while running low-level media tools, such as PC
Tools or Microsoft Anti-Virus, may cause a crash.  It is best to reduce computer
activity to a minimum while using such tools.

Multimedia and Game Applications

These types of applications, whether they are run in the PC or Macintosh
environments, will see a marked performance improvement with the installation of
a memory SIMM onto the DOS Compatibility Card.  QuickTime application
performance is especially improved with the addition of a SIMM.

Rebuilding the Desktop

If you need to rebuild the Macintosh desktop, you must either wait for the
desktop to rebuild while in the Macintosh environment, or switch to the DOS
environment and remain there until the rebuild is complete.  Switching back to
the Macintosh environment during rebuild will cause the Macintosh to crash.

Using PC Tools Pro 9.0

The CPTASK.EXE utility (Central Point Task Manager) is incompatible with the DOS
Compatibility Card.

Using MWUNDEL

MWUNDEL does not work on shared folders, so files deleted by the PC in shared
folders will not be recoverable.  However, files in shared folders can be
recovered if they are deleted from the Macintosh.  Use a Macintosh utility such
as Norton Disk Doctor.

Using After Dark 3.0

Do not use the PC Setup control panel "Switch at Startup" option when using
After Dark. When switching to the PC side, make sure After Dark 3.0 for the
Macintosh is turned off.

Using the Serial Port

If you are using communications software that uses the serial port, the



following are known errors:

•  For Procomm, the auto-answer mode does not work.

•  For LapLink, transferring files between two machines may not work, especially
for large files.
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